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Copyright and Disclaimer 

This document, as well as the software described in it, is furnished under license of the Instant 

Technologies Software Evaluation Agreement and may be used or copied only in accordance with the 

terms of such license. The content of this document is furnished for informational use only, is subject 

to change without notice, and should not be construed as a commitment by Instant Technologies. 

Instant Technologies assumes no responsibility or liability for any errors or inaccuracies that may 

appear in this document. All information in this document is confidential and proprietary. 

Except as permitted by the Software Evaluation Agreement, no part of this document may be 

reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, 

mechanical, recording, or otherwise, without the prior written permission of Instant Technologies.  

Copyright © 2005 - 2020 Instant Technologies, All rights reserved. 

Trademarks 

All other trademarks are the property of their respective owners. 

Contact Information 

See our Web site for Customer Support information. 

http://www.instant-tech.com/ 
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CHIME GDPR INSTALLATION AND 

USAGE GUIDE 

INSTALL CHIME GDPR TOOL 

Before you can perform any GDPR operations you need to prepare a few things to use the application. 

The Chime GDPR Tool needs to be installed on a Windows based system and you will also need to have 

an up to date copy of the settings file used on the Chime server that you want to perform GDPR 

operations on. 

Note: you do NOT need to install this application on the server that Chime is running on, however you will 

need to have network access to the to the Database server that your Chime instance is using. If you 

choose to run this application on the server that Chime is hosted on, ensure that the server has enough 

processing power to run the application in addition to the load created from the Chime instance. 

INSTALLING THE GDPR TOOL 

1. Run the GDPR-Installer.msi file. 

2. Click Next. 

  

Figure 1: Begin GDPR Tool Install 

3. Select the folder you want to install the GDPR Tool to then click Next. If you prefer to leave it in 

the default location, click Next.  
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4. Click Install. 

 

Figure 2: Install the GDPR Tool 

5. Once the Installer completes the setup, click Finish. 

 

Figure 3: Finish Installing the Application 
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SETTING UP THE CHIME GDPR TOOL 

SELECTING THE SETTINGS.XML FILE 

Once the GDPR Tool is installed, you will need to connect the application to the Chime server that you 

want to perform GDPR operations on. You will need to select the settings.xml file for the Chime server to 

perform this operation. 

1. Click the Select File… button. 

 
Figure 4: Initial State of the GDPR Tool  

2. Navigate to and select the file location of the settings.xml file.  

3. Click the Open button. 

 
Figure 5: Select the Settings.xml file 
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Once the settings.xml has been picked, the app will notify you if the action has been successful. If it tells 

you that you are now connected to the Chime Database, you will then be allowed to enter in the name of 

the user you with to perform GDPR actions to. If your settings.xml does not work however, there may be a 

problem. Feel free to contact support@instant-tech.com for assistance. 

 
Figure 6: Chime Database Successfully Connected  

Once the settings.xml has been chosen, it will be saved as the default settings file any time you reopen 

the application. If you want to choose a different settings file, you can click the Select File… button in the 

top right of the application, or choose the Chime settings.xml from the File menu. 

FILE AND OPTIONS 

After you have set the settings.xml file the File and Options menu items will be useful to view and 

configure the settings for the GDPR application. 

 
Figure 7: File Menu 

The File menu gives you access to three different actions to manage the GDPR tool and review logs and 

reports 

• Choose Chime settings.xml: Opens a file dialogue that allows you to pick a new settings.xml 

file that the GDPR Tool will use to connect to the Chime Database the settings file points to. 

• View Logs Directory: Opens up a new File Explorer that points to the current location that you 

have saved as your log file directory. 

• View Reports Directory: Opens up a new File Explorer that navigates to the current location that 

you have saved as your reports directory. 

mailto:support@instant-tech.com
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The Options menu gives you access to two different actions to manage the settings GDPR tool: 

• Reporting and Logging… 

• Message Deletion 

 
Figure 8: Options Menu 

OPTIONS FORM 

The options form allows you to modify settings with in the GDPR Tool such as the locations of the logs 

and reports locations and the option to automatically have reports generate in the specified directory. 

 
Figure 9: Options Form 

Note: If you click cancel, or close the form while modifying any of the settings mentioned below, any 

changes you have made will be reverted and lost. Click the OK button after making changes to save and 

close the form. 

Automatically Generate Reports: 

If you would like reports to be generated for any of the GDPR actions that are performed while using this 

tool (or any remote actions) check the Automatically Generate Reports checkbox in the options form. 

Otherwise, you will be prompted if you want a report generated for any GDPR action that you perform. 

Reports Location: 

The options form shows you the current directory path you have set for your reports location. If you would 

like to change this location, simply click the Select… button and select the directory path of the folder you 

would like to use for the reports. Note: this chooses the default location of the reports, if you choose to 

leave the automatic generation setting unchecked you will still be able to choose a custom path for each 

report that you create. 
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Below the Reports Location, you are also able to choose the number of days to retain reports in the 

Reports Directory. If you would like reports to never be deleted from that directory, you can set that 

number to 0. 

Logs Location: 

The options form shows you the current location you have set for your logs to generate. If you would like 

to change this location, simply click the Select… button and select the directory path of the folder you 

would like to use for the Log files. 

Below the Logs Location, you are also able to choose the number of days to retain reports in the Logs 

Directory. If you would like logs to never be deleted from that directory, you can set that number to 0. 

BULK MESSAGE DELETION 

The Bulk Message Deletion is a feature for the Chime GDPR Tool that allows you to remove all of the 

messages from the Chime database before the specified retention period. In this form you are able to 

select the number of Chat Retention Days as well as if the feature can be run from a command line 

argument.  

Note: If you click cancel, or close the form while modifying any of the settings mentioned below, any 

changes you have made will be reverted and lost. Click the OK button after making changes to save and 

close the form. 

 
Figure 10: Bulk Message Deletion Form 

Chat Retention Length: 

This feature allows you to set the chat retention length for the application. The number you choose here 

will be the number of days you wish to keep chat sessions for. If you click the Run Now… button you will 

be performing a bulk message delete action. This is not a test and it will permanently remove messages 

from any chat sessions outside of the retention period. If you want to test this feature, we recommend you 

use a test server to perform the test on, or make a copy of the Chime database that you won’t mind 

having data removed from. 
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Keep essential MetaData for charts and metrics reporting: 

Checking this will cause the GDPR Tool to go through the meta data and keep in fields that are useful for 

our charting and reporting. These fields include: skillTags, Session ID, Session GUID, Queue, and ID. 

Enable deletion via external command line arguments: 

This aspect of the feature will be covered more in a future section detailing how to set up the feature with 

Task Scheduler. This setting must be checked for this feature to work, otherwise the task will fail. 

 

OVERWRITE/REMOVE CHIME USER 

The main feature of the GDPR Tool is the ability to either remove or overwrite all data for a specific user 

from the Chime Database. To begin this, you must have first connected the application to the database by 

selecting the settings.xml file of the chime server you with to modify. 

CHOOSING A CHIME USER 

After connecting to the Chime Database, you are now able to search for a user that you want to perform 

GDPR actions on. 

1. Type in the name of the user you want to edit in the Text box in the middle of the application 

window. 

 
Figure 11: Search for Chime Users 

2. Click the Search for User button. 

3. Select the user you want to edit in the list of users that appear. When you click on a user to edit, 

details about this user will appear in the textbox to the right such as first name, last name, email, 

user role. Users are stored in the database. 

Note: The same user might have multiple entries in the list if they are registered as an Agent and 

a Guest. Additionally, users that might come in with different emails may show up as multiple 

entries. 



Page 10  Copyright © 2020 Instant Technologies. All rights reserved. 

Rev 4 

May 6, 2020 

 
Figure 12: Chime Users Available to Modify 

4. Choose the GDPR operation that you would like to perform on the Chime user: 
 
Remove All User’s Data In Chime: 
This option will redact all contact information in Chime about the user you are performing this 
action on. Their name, email, login name, etc... will all be removed from Chime, and any that they 
were in will have their names redacted and any chat information and meta data will be deleted 
 
Overwrite Contact Information In Chime: 
This option will redact all information in Chime about user you are performing this action on. Their 
name, email, login name, etc... will all be removed from Chime, and any chats that they were in 
will have their messages redacted and any chat information and meta data will be deleted 

5. Click the button for the option you wish to perform. 
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6. Confirm that you would like to perform this action. Click the Yes button. 

Note: This action can not be undone, once you perform one of these GDPR operations on a 

Chime user their data will not be recoverable, and they will be displayed as ‘Redacted Agent’ or 

‘Redacted Guest’ in all of the Chime UI and in the Database.  

 
Figure 13: Remove all Chime Users Date 

EXPORT OPERATIONS TO CSV 

Once you have initiated the GDPR operation, you will be prompted if you want to export the results of the 

action to a CSV file. The report will give you information such as what user the GDPR Tool has modified, 

(name, email, user role, modification type), number of sessions edited, messages edited, comments 

edited, personal info removed etc… 

1. Click Yes 

 
Figure 14: Export to CSV 
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2. Choose the file directory location where you want the report to be saved to. 

 

Figure 15: Choose Where to Save the Report 

3. You will receive a message saying that the user has been removed/overwritten from the Chime 

Database. 

 

Figure 16: Chime User Removed from the Database 
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4. Open up the report from the GDPR operation from the location it was saved. Perform any actions 

with this such as adding it to records, providing it to the GDPR user etc… 

 

Figure 17: Chime GDPR Tool Report 
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SET UP BULK MESSAGE DELETION WITH TASK SCHEDULER 

GDPR APPLICATION SETUP  

If you want to set up the bulk message deletion to run on a schedule, you will need to configure it so that 

it can be run remotely from a service such as Task Scheduler. To get the application ready for this setup 

you will need to first configure the options to allow this feature to work as intended. 

1. Navigate to Options → Bulk Message Deletion. This will open up the bulk message deletion 

form. 

 
Figure 18: Message Deletion Settings 

2. Select the number of days you want to retain chat messages for. 

3. Check of the setting labeled ‘Enable deletion via external command line arguments’ 

4. Click the OK button to save the settings. 
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CREATE A TASK 

Now that the GDPR application is configured, you can start setting up a task to run the Message deletion 

on a scheduled interval. 

1. Open up Task Scheduler 

 
Figure 19: Create Task 

2. Click Create Task… on the right side of the program. 

GENERAL 

3. Name your task something sop that it is easily identifiable as the GDPR message deletion task. 

Ex: GDPR Bulk Message Deletion. 

4. Give the task a description that describes what it does and how often you will have it run. 

 
Figure 20: Create Task - General 

5. Set the task to Run whether user is logged in or not 
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TRIGGERS 

6. Click the Triggers tab to move to the next section 

7. Click New… 

 
Figure 21: Create New Trigger 

8. In the ‘Begin the task’ dropdown, select the ‘On a schedule’ option 

9. Here you can choose how often you want it to run (once, daily, weekly, monthly) 

10. Select what date and time you want it to run for the first time and how often you want it to occur. 

The time you choose here will be the time it runs every time in the future. 

 
Figure 22: Set Schedule 

11. In ‘Advanced settings’, choose if you want to use any of the settings. If you would like to run the 

app in hour intervals instead of day intervals check off ‘Repeat task every:’ and set the time to 

how often you want it to repeat and set the duration to indefinite. 

12. Additionally make sure ‘Enabled’ is checked. 

13. Once you have completed setting this up. Click the OK button. 



Page 17  Copyright © 2020 Instant Technologies. All rights reserved. 

Rev 4 

May 6, 2020 

ACTIONS 

14. Click on the Actions Tab. 

 
Figure 23: Pick New Action 

15. Click New… 

16. In the ‘Action’ dropdown, choose Start a program 

  
Figure 24: Create New Action 

17. Click Browse… 

18. Select the GDPR-Tool.exe application file (by default it is in C:\Program Files (x86)\Instant 

Technologies\Chime For Lync GDPR Tool) 

19. In the ‘Add arguments(optional)’ text box, write ‘BulkDelete’ 

20. Click OK. 
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CONDITIONS AND SETTINGS 

21. Click the Conditions tab. 

22. If any of the settings here are applicable to your deployment method, configure them as you like. 

 
Figure 25: Conditions Tab 

23. Click the Settings tab. 

24. If you would like the ability to run the task manually in addition to the schedule, check the setting 

‘Allow task to be run on demand’ 

25. Check ‘Run task as soon as possible after a scheduled task is missed’ 

26. Check the ‘Stop the task if it runs longer than:’ setting and choose how many hours you want to 

stop after. (Be aware, the application can delete up to about 200,000 messages in an hour, so if 

you need to delete more than that, set tis setting accordingly) 

 
Figure 26: Settings Tab 

27. Check the setting ‘If the running task does not end when requested, force it to stop. 

28. Click OK, this will create the task. 
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29. Your Task should be set up correctly. If you enabled the manual task run feature, you will be able 

to run the task right away if you want. Otherwise, make sure the task is enabled, and then wait for 

the time you chose in the triggers settings to pass. 

 
Figure 27: Completed Task Setup 


